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1. Main Window

Menu bar

C Aero-Drag Calculaar

Toolbar i

Dat
| Filename | Density (ka/ir?) Cd 0 al a2 ] Add
Frame for \!7 N1-darig | sz 0.26386 001487 23309106 033776 0,00055 Dataset
¥ N-Borig.tut [1IRRE=E 0,29045 0,01513 238,15398 034564 0,00023 ez
inp ut/o UtpUt v N3 201ig 4 115523 03105 0,01462 22317881 035917 0,00052 e controls
~ N13-16aiig et OIS 030629 0oag 20680473 036445 0.00035
E N17-200iig it 115523 033618 00124 19451933 040002 0.00064 Calculale
ata
Draw
Mean
B |
Graphs
Graphs —
| oay | e PTHITTTY g

2. Add Files

First, check if the right data format is adjusted (see sec. 9.3 Adjust File
Format). Use the command button Add.. in the dataset control area or File >
Add... in the menu bar for adding a file to the data grid. Select one or more
files in the “Load” window. If the data format of the file is equal to the adjusted
data format, the file will be added to the data grid.

[2)M19_ow i .out

5
Iiﬂ Mode Wiew Sel BEE
(4] raa [Z] m1a_cwe_vw1 txt

4] a1 [Z] Mzo_ow.bxt

2] MILY_UW Xt

2] Mz0_0W_W1 out
[Z] m13_wo, [Z] Mz0_owe_wi txt
g s =] p14_wo kst
Print Opkions. .. B 4w,
Prink,..

1+ Dateiname: |"MDS_WD.txt" UBATO_ W0 b AT T ﬂ Offrien |
Ezxik | !
Dateityp: | DataFets [7 bt out] ﬂ Abbrechen

Open “Load” \
window Select files
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[ Fileriame: Desisity d fril all a2 ]
I B0 W0 bt
[ FA 10w/ 0tk | |
[ FAT1_ 0wt [ |
r P12 0 bt [ ]
Files are
added

3. Remove Files

For removing files, select the files and click the Remove button in the control
area. For removing all files, use the command button Remove all.

Select all
datasets
Remove
[ Filerarme Add...
= T selected
= ot Bemove A files
v M0 w0 bt |
v M11_OWw bt n Remove all N
[ M2 0 bt |
Calculate
Select files with Remove all
check box Draw files from
list

4. Calculate

If the files are added successfully to the list, select the files to calculate and
ensure that all input parameters are set for these datasets ( see sec. 10 Set
Input Parameters). Use the command button Calculate for calculating the
drag coefficients and the deviation Q of the measurement file from the

solution of the ODE.

u Filename el Press Calculate
B MOS0 bt Femove to determine
E‘ m?‘;\ﬁr: : drag coefficients
_ LA b Remove all
@ M2 0 bt m and error
Select files ﬂ}
to calculate Diraw
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The solutions of the calculation are displayed in the columns beside the
filename-column.

v Filename Density Cd fil al a2 B]
v B17_w/0. ket | | 1,18523 030161 001126 176.52919 (0,35888 0.00017
v b T8 W0, ket L] 1,15523 0,31464 0,01041 163,14522 037438 0.,00014
v b1 0. bt | 1,15523 028413 00173 28063915 (0,33808 0.,00051
v b420_00/. ket | 1,18523 0,33448 001277 20016027 0,35759 0,00029
Displayed
solutions

The graphs below the filegrid display the velocity-time history, the calculated
accelerations and the ¢p, f,, and Q values. The Zoom control works for the

first and the second graph (see sec. 12.1 Zoom).
Use the Tab control for selecting the different graphs.

el e, ~ | Zoom

44

42 controls
40
38
36
k]
32

Velocity-
time history

all] . mis

s |oaw RACTH w0 |

/ values

033 4

03 A
031 A
03 o

029 4

028 4

1 2 3 4 conlig

User Guide — Installation Guide 4-24



team e

| ey | oo DT o |

fi0 / f,o'
0018 o 1 values
o7
0016
0015 |
o4
003 i
ooz A
001 A g
oo s

1 2 3 4 config

) | e | cd U

2 7 Q
00005 4 R 1 values
0.00045 |
oo
000035 |
ooz L

0,00025 1
0000z 1
0,005 1

1 2 3 4 conlig

A further possibility to analyze the calculated c¢p and f, data is the
“Comparison tool” (see sec. 8 Comparison) and the menu option Diagrams...

(see sec 12.4 Compare Graphs).

5. Draw

Use the command button Draw for displaying the different velocity-time
histories without calculating.

[ Filetarme Add...

[ EIERE, B .

v b1 000 bt B

J? LT L Remove all

) M12_ 0w bt ™ Press Draw to

\ Caloulate visualize the

Select files / vlelom'ty-tlme
to draw Draw histories
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t] . mds
46

Zoom
controls

Velocity-
time history

Mean

6.

This tool makes it possible to build the average of two or more files, e.g.
average the different data points at the same time to one data point. This is
useful if it is necessary to compare the different runs of one car-configuration
with runs of other configurations.
First of all, select the Advanced I (Mean) mode in the menu bar. The
command button Mean is then displayed in the dataset control area. Select
the files and use the button Mean to build one average file of the selected.
With this command the “Save” window will be opened. Choose the filepath and
filename for the averaged file and confirm. The original files will be removed
then and the averaged file will be added to the datagrid. Now it is possible to
work with this file like the normal input data files.

Aero-Drag Calculator Choose the r Filename
. . advanced
fafal-0 Wiews Setkings 7 d | k09 W00 bk
mode —
@ Simple Mode v B 100 ket [ |
= w Advanced I (Mean v PA11_Ow bt |
Advanced IT (Couple) Select files [ P12 0 bt [ ]
for Mean
Speichern unter @
Speichern in: |DMeanadD ta j L] =k B
L\é E?ﬁq.txt
5 ata 5-8.kxt
Zuletzt [2] Data 9-12.txt
R [] Data 13-16.t0
[£] Data 17-20.txt
e [Z) M1-d.bxt
eskiop E -5t
Choose the | ] Breere
. [Z] M13-16.bet
fllepath for L= [2) mi7-z0.tet |~ Enter the
averaged 313 filename for
file -
Arbeitsplatz averaged
‘,}} Dateiname: Data 1819 j | Speichem | flle
Netzwerkumgeh  Dateityp: DataSets [~ tat] Abbrechen
ung
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| Filenarne Dlensity Cd fil all a2 a
I~ MO0 bt L
I~ 120w/ st L
I testtet_ NI 0,31246 0,01 453 22762027 0,3718 0,00043
Use averaged file
like normal files
7. Couple

First of all, select Mode and Advanced Il (Couple) in the menu bar for
switching to “Coupling” mode. The command button Couple is then displayed

in the dataset control area.

C Aero-Drag Calculator

Ghlal-N Wiew  Settings

= Simple Mode
advanced I (Mean)

v Advanced II {Couple)

¥

Switch to
Advanced Il
(Couple)

for coupling

If you would like to use the coupling mode of the program, it is necessary to
adjust several settings in the “Options” window. Use Settings and Options...

Setkings

Open
,Options*
window

to open the “Options” window. Switch to the tab Coupling to adjust the
coupling settings. Select in the first frame which coefficients should be coupled
during the calculation. Choose in the second and third frame whether you'd
use a constant or a variable coupling coefficient A. If you choose the mode for
calculating with constant A, enter the value in the text box beside. If you use a
variable A, enter the upper and lower boundary and the number of steps for A

with the slider.
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C Options rg|
Select tab — _
C li mwﬁouphng l File Format ]
oupling o 1 — | Choose
ouple L.
. e —T] coefficient.
Choose for for constrain
calculation with wstant
constant A " Lambda constant —_ 1 Enter Value
for A
Yanahle
ChOOSG'fOI' . * Lambda variablz
calculation with
variable A Start 1 to 000 — | |
17— | Enter limits
Mumber of steps for lambda for A
50
Adjust 1
number of
steps for A
0K | Cancel ‘

After the successful adjustments of the coupling mode, add the necessary
input parameters for the datasets (see sec. 10 Set Input Parameters) and
select the files for coupling. Use the command button Couple to start the

calculation.
[ Filenarme dd.
] M09 bt
¥ M10_W0 bt ™ Remave
ﬁ BT 00 bt [ ——
I_'\ AT 2_ 0 it ]
Calculate
Select files
for Couple Diraw
fean...
Press —  Cowle |
Couple to |C|:|uple kwio or more datasets|
start the
calculation
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Case 1: constant A: After the calculation, all calculated values for the entered A
are displayed in the datagrid. The output of the graphs is similar to the output
of the standard calculate mode.

Case 2: variable A: After the calculation, the values for the lower bound of the
entered range for A are displayed in the datagrid. The output of the graphs cp,
f., and Q are now dependent of the logarithmic A. The various datasets are

drawn with different colours.

an | am | om | oa |

4 Al
na 4
nas
0
035 4
0x
na0s
03

05 1 15 2 25 3 35 lo(l

vy | &t | ot i 4 o ]

fi0 ﬂ
0o1ss £
oms
oolas +
oot4
0o T+
0'013 1 1 1 1 1 1 1 1

05 1 15 2 25 3 35 log(l

vy | &l | cd i

ooomt +
oo
00003 -
n0ooog -
00007 +
00006 +
00005 +
00004+
00003
00002 £

05 1 15 2 25 3 35 lagll
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Comparison

Use the analysing method “Comparison” to compare the different cp and f,,

values. Precondition for this is that the files to compare are already calculated.
Choose the button Show comparison mode in the toolbar or use View >
Data Output > Data Comparison in the menu bar to switch to comparison
mode.

Eh H: WD Setkings ¢
= E Diagrams. ..

|Shn:uw cﬁrqparisun n'u:u:lel

LN N Graphs

I -5 Corvparson

Open
~-comparison”
mode

The graphs are hidden then and the frame for the comparison mode is
opened.

Comparison

Drata 1-4.bxt
[Data 5-8.kat Ed

Drata 9120t 04 -
Data 13-16. ket
Drata 17-20. bt

035 +

03

025 +

Configuration |1 - 02
Add s> ’
015 +
- : 7 > 3 ) 5 config
\ Frame for
comparison

Use the button Comp settings to open the settings for the comparison. Adjust
in the frame View which type of coefficient should be displayed. Choose in the
frame Add mode how the data should be added: Standard means that the ¢p
or f, values are added directly, Mean and add means that the values of the

selected files are at first averaged and then added, Add reference means that
the values in the text boxes below are added. Select in the frame Color/lcon
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which type of icon should be used for adding. If the two modes Mean and add
or Add reference are adjusted, it is also possible to select a colour by clicking
on the icon or to enter a description for the data point.

Select Select add
displayed mode
Data 1-4 bt coefficient
Data 5-8.kat
Data 3121t
Data 13-.t:-:t Wiew / Add Mode
Data 17-20.tat & Cd ki d
Color 7 oo i Mean and add
Configuration |1 - E hl .  Self el
| adde | \ |
Coxnp sethings... | \ .
\ | Choose icon Enter
A\ reference (only
Open e “Add” mode 3
. Enter discription mode 3)
settings for P
. (only “Add
comparison mode 2 and 3) Select colour
(only “Add”
mode 2 and 3)

After the successful adjustment of these settings, select the files whose ¢p and
f., values should be added. Furthermore use the combo box for adjusting the

configuration of the selected datasets. Click Add>> for adding the coefficients
to the chart.

Comparison

Select files N

Rk o
Data 312kt 034
Data 13-16.tet 033
033
0325
032
0315 u il

031 = = i
0,305 =

Choose ~
configuration

Clear chan — o3 \
Add ¢p and T o i D'ZEE ; z 3 ¥ 5 i
Data and inseription...
f.o - values
Displayed
datapoints
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Use the button Data and inscription to display the values and the inscription
of the added datapoints.

Data 1-4.txt C |Data comparison Cd values @
g Config 1 Config2 Confia 3 Config 4 Config§ ~
Data 581t 032476 [BlDats 1440t 03161 Data 566 031563 M| Data 120t 030674 [BIDats 13160t 03083 [EData 17200
Data 312t 0,318 Conf.1 ref.-valus 0311 Cont.2 ref.-value 0,321 Cont.3 ref.-value 0,31 Conf.4 ref.-valus 0,309 WMConi s el -vae
Data 13-16.txt
Diata 17-20.kst
Configuration |5 - v
ccod
Clear chart Open
Comp seftings... datag”d:
Data and inscription... Values and
inscription of
coefficients

Press the button <<Del for removing the last added datapoint from the chart
and the grid. The button Clear chart clears the chart and the grid completely.

Data 1-d.txt
Data 5-8.kxt
Data 912kt
[rata 13-16.kat

Drata 17-200kat

Delete last added
dataset from the
chart and the grid

Canfiguratian

| add>s |

Clear ch
— an\_,ﬂl\ Clear chart and grid

Data and inzcription. . |

D

completely
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9. Options

Use Settings and Options... to open the “Options” window.

Open
,Options*
window

9.1. General Settings

9.1.1. Graph Settings

team

The first frame Graph settings contains adjustments for the graphs in the
software. Enable the checkbox Draw solution of ODE for drawing the solved
differential equation of motion in the “v(t)-graph”. Use the checkbox Show
grids to display grids in the graphs. It is also possible to set the background-

colour with the two radio buttons beside.

Check for C Options X
drawing
Solution of General Settings l Eoupling] File: Formal]
ODE in V(t) Graph settings
graph

[~ Draw solution of ODE BackgmunW, -
Check to — ¥ Shaw grids (& Black " white
display grids
in all graphs Srmooth

[v Smooth input data //
Check for — /Fac:tor data leducti /
smoothing T
input data

Load Delimiter for input parameters

Enable fora | —ft—— I Show file preview [Comma " A |
preview of
the dataset
before it is
entered to oi% Camez!
the datagrid
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9.1.2. Smooth Input Data

Use the option Smooth input data for reducing the amount of data points in
the file when it is opened for the calculation. With this mode a definite number
of data points is averaged to one. Adjust this number with the slider below.

9.1.3. Delimiter for Input Parameters

Select with the combo box which type of delimiter is adjusted in your system
settings. All inputs in the several text boxes are then transformed to this
delimiter.

9.1.4. Load

Enable the checkbox Show file preview to take a look to the content of the
file before it is added to the datagrid. If this mode is selected the window “File
Preview” is opened when the user wants to add a file to the data grid.

Click to load
a file to the
text box
beside Import all
files to the
C File Preview 3 data grid in
Select file to N the main

display it in Fle Preview Lo datasct.. window
the list [ =

Import datazets

below 45 5919763650055 3 Q Clear

45 52705553905891

455718402777 77795 Cloa et j combobox
45.43795444444444 and list
45.43703743995999 _

45, 38675722222225 Set fle fnrmal..j.

45,3301 46385855906 .
45 7759000000001 ™ [ set the file
45 71 (1520155555557 Cancel

45, 1530059444442 format of
45,10433388885889 added files
45, (3908305555555

44 95371 3BAEERE404

44 AN7INEEREEREE?

44.8521375

44.800584722222204

44 746774444444484

44 GR9971 BEBEREES

44,6205 7656E6EE68

44 5EE4EET1111113 S

!

Click the command button Load dataset... to load one or more files to the text
box. If more than one file is added, select the file which should be displayed in
the text box with the combo box. Press Import datasets to add all files to the
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data grid in the main window. Use Clear list to clear the text box and the
combo box. Press the command button Set file format... for adjusting the file
format before the files are added to the data grid in the main window.

9.2. Coupling
See sec. 7. Couple

9.3. Adjust File Format

Use the third tab of the “Options” window to adjust the file format of the data
sets. There is the option to decide between three different formats.

C Options ['5__<|
GeneralSetting&] Coupling  File Format l
" Format 1 I
Select data
format 12 223
- Sample rate 01 =
40_ZE& F
EEGEELS [ Input data in kdh
39.047
™ Format 3 li
-
ok | Cahcel |

Format 1: Use Format 1 if the file contains information about the time in the
first column and the velocity values in the second column. The delimiter
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between the time and the velocity has to be a space. Enable the check box if
the data is given in km/h.

i* Format 1 0000 4% 9678 \
0.001 43.5629

0.00Z 4Z.9345

Enable check
box if input data
is given in km/h

Format 2: (Standard format). Use this format if the velocity data is saved in
one column. Enter the sample rate for the file and enable the check box if the
data is given in km/h.

/ Enter sample
Rk rs Sample rate 01 = rate

40, EZLe

39.938 [ Input data in km/h

39.047 \\\\\

Enable check
box if input data
is given in km/h

Format 3: Use Format 3 if the velocity data is separated by a semicolon,
space or tabulator. Enter the sample rate for the file and enable the check box
if the data is given in km/h. Adjust the delimiter with the combo box.

Enter sample
...................... / rate

f Format 3 44.346743.235 Sample rate n1 s

;4. 986:41.87
Drelimiter l—_| -| —— | Select delimiter

4
v Input data in km/h
— T | Enable check

box if input data
is given in km/h
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10. Set Input Parameters

After the successful import of the files it is necessary to add several input
parameters for the calculation. Open the “Input Parameters” window with
Settings>Input Parameters.

Settings B
Zettings Open ,Input

| Parameters”
window

Options. ..

First of all use the combo box to select a file. Enter the parameters for the
selected file in the text boxes. Choose with the check box Enter dynamic
mass if the calculation should be fulfilled with a dynamic mass. If the check
box is not enabled, the dynamic mass is automatically set to 103% of the
mass of the vehicle. Enable the check box Data valid for all data sets if the
adjusted parameters are the same for all files. Use the command button Add
to connect the values with the selected data set.

C | Input Parameters E] / Select data
sets for
|Diata 1414t =~ adding input
parameters
Frontal area 206
Enter
Enable for Mass of car 8 ks | parameters
calculation Pressure 95520 Pa
with
dynamic Temperature 1459 °C
mass [v Enter dyniamic mass
Check if Diynamic mass 1602 kg
parameters | Add the
should be v Data vald for all data sets entered
added to all parameters
of the data | Addda ok |
sets

After the successful connection of the input parameters with the data set, all
text boxes are inactive. Use the button Change data if it is necessary to
change one or more of the parameters.
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C |Input Parameters

IData 1-4.kat ;I
Frontal area I 206 e
Mazs of car I 1597 kg
Pressure I 95520 Pa
Temperature 1449 °C

[¥ Enter dunamic mass

|

Dynamic mass 1602 ko

v Data valid for all data sets)
Change ~J

parameters \’FBRQE datal Add data | 0

-

11. Print

The software makes it also possible to print all input/output parameters and
the displayed graphs. Open the “Print Options” with File > Print Options... in
the menu bar.

=N Mode VYiew Se

add. .. Open ,Print
Remove OF)'[IOHS“
i window

Print directly ~————___ Print...
Eik
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 Print Options

Select which
type of data Data Graphs
ok,

shpuld be Input Data W welt]
printed Cancel

v Solutions v alt] L | Print the

selected
Comparizon | Celle] / .
------- Print... ltems
[ Cd v fr ()
v il [ Ol

First of all select which type of data should be printed. Use the command
button Print for printing the selected items.

It is also possible to print without adjusting the print options. Use the button
Print in the toolbar or select File>Print in the menu bar to print directly.

C Aero-Drag Calculator

File Mode Wiew Settings

Print directly

12. Further Tools

12.1.Zoom

In the “v(t)” and “a(t)-graph” it is possible to zoom into the chart. Use the

button to switch on the zoom mode. Click into the chart and keep pressing
the left mouse button while drawing the zoom-rectangle. The selected area is

then expanded to the size of the graph. Press the |E| button to zoom-out to
the original size.
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Wit an | cf Draw zoom rectangle \
(Keep left mouse _
Gl /D.l
4;“] o button pressed) Press button
M 1 for zoom-out
42 4
40 +
® T — Press butFon
® 7T \ for zoom-in
RIS
2 4
5| 16 1I5 26 25 b.s

12.2. Adjust Colour for Datasets

Click on the coloured shape beside the filename in the data grid to open the
“Colour” window. The selected colour will be the new colour for the data set.

v Filename Click to change
v M20_0W_W1.out N / colour

v M17_wiO_v1.out L]

[ NTE_Ww0_41. out |

v N19_0% 1. out |

12.3. Reference

If the “Advanced Il (Couple)” mode is activated, it is possible to add reference
lines in the cp and f,,-graphs, e.g. wind tunnel data for cp. Click the Rf button

to open the “Reference” window.

I -

od /ﬂ

033 +
Press to

0325 +
open

032t w
~Reference

0315 + .
window

0.3

0308 +

D,I5 1 I 1 ,‘5 2 I 2:5 logll]
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Click to
adjust colour

C Reference
Yalue
Reference for Cd
Color/Style
\. Dash -

QK | Cancel

|

—

team

Enter
reference
value

X

Select style
of reference
line

Enter the reference value in the text box. Use the combo box to select the line

style and click on the shape to choose a colour for the reference line. Confirm
with OK and the line will be added to the graph.

W | A Cd fil

Cd
033 4
0325 -
032 -+

035 4

0 ————

Added
reference
line

0305 -+

0s8

logfl]

12.4. Compare Graphs

Use Viewss>Compare Graphs... to open the “Compare Graphs” window.
Select with the Tab control which graphs should be displayed.

Sekktings ¥
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C |Diagrams

qy | e EW

Cd

Select
displayed
graphs

034

033

032 4

031 4

023
ns 1 15 2 25 3 35 4 45 log(h)

W | am | o

00155 4
0016

00145
0,014 4
00135 A

0013 4

05 1 15 2 25 3 35 4 45 lag(h)
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13. Installation Guide

Double click “setup.exe” in the installation directory.

The installation wizard is started. Follow the instructions of the wizard.

Aero-Drag Calculator Setup

#2 Aero-D rag Calculator Setup

Begin the installation by clicking the button below,

Click this button ta install Asro-Drag Calculator saftware to the specified
destination directory.

CiJProgrammeldero-Drag Calculator!, Change Directory

Exit Setup

Click here to start the Click here to change the
installation target directory
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Aero-Drag Calculator Setup

s= Aero-Drag Calculator, - Choose Program Group @

Setup will add items ta the group shown in the Program Group box,
You can enter a new group name or seleck one From the Existing
Groups lisk,

Microsaft wweb Publishing
Zubehdr

Continue | Cancel

To change the start menu entry,
enter a new name here

After clicking Next the application will be installed:

= Aero-Drag Calculator Setup
Destination File:
CHWINDOWSsystem3Z \MSHELYED, OCy,

[ 2z

The wizard will indicate, when the installation is finished:

Aero-Drag Calculakor Setup was completed successFully.

Ik |
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